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From The Editor’s Desk

PhotographyBB online magazine issue thirty-one: last days of summer fun...

dave seeram is the editor in chief for PhotographyBB online magazine. as 
the administrator of the PhotographyBB Website and forums, dave is also 
an experienced author of several Photoshop® actions and tutorials which 
can be found on http://www.PhotographyBB.com

Welcome to the 31st Edition of the PhotographyBB Online Magazine. It’s been a very busy 
month for the writing staff here as most of us have been either out of town (and writing 
articles), or writing articles while picking up the slack from those who are out of town on 

vacation! Needless to say, we wanted to make sure that even though some of the crew is off holidaying, 
we couldn’t forget our readers of course! That’s why this issue is full of tutorials, tips, and techniques to 
satisfy your photographic appetites as summer comes to a close. That’s nothing to be sad about; the most 
colourful and photogenic season is just around the corner begging you to shoot it when it gets here.

We have a great team here at PhotographyBB, and most of you are familiar with what everyone does 
here. However, there are a couple of folks who play a key role in the production of this magazine, whom you 
may not know about. So, I’m going to use this editorial to recognize two people who are very important; 
both to me, and to you. You have all been enjoying these magazines (hopefully!) over the years, and as the 
editor I thoroughly enjoy publishing them. We have a fantastic team of authors who love what they do 
because of you guys and girls, but what many people don’t know is that there are two gentlemen who have 
been working extremely diligently behind the scenes and are an integral part of getting this e-magazine 
published each and every month. Who is this mystery dynamic-duo? Let’s find out...

I’m talking about the PhotographyBB Forum Moderators, Chris Styles (aka “Nobby”) and Greg 
McComsey. These talented guys generously spend a part of each day at the forums, maintaining and 
keeping them safe from spammers, scammers, and any other nasty sorts on the net. They also do a whole 
lot more than just forum maintenance; Chris and Greg are two of the most helpful individuals on the 
forums, offering advice and assistance to anyone who asks, and honest words of encouragement for all 
the beginners who are brave enough to share their first photographs with us. 

How does all of this help the seemingly independent PhotographyBB Online Magazine? Simply put - 
without these two fine gentlemen, I would not have enough hours in the day to work with our writers and 
complete the editing/publishing phases of the magazine. These guys make it possible, and my warmest 
thanks goes to them. You can learn more about Chris and Greg who are now featured on our “Meet the 
Team” page (page 4). A lot of what they do is “behind the scenes” type stuff, so if you enjoy this magazine, 
drop by the forums and say hi to these guys.

Of course, we wouldn’t have a great magazine without the enthusiasm and passion of the writing 
staff here. Again, they have done a spectacular job under tighter deadlines than usual this month. Thanks 
to them and to all of you for reading. This issue has a lot of fun techniques to experiment with (especially 
lighting/flash techniques), so grab your cameras, flashes, teas, coffees, iPads, notebooks, etc... and enjoy 
this summer edition. Happy Photographing!

Dave Seeram
Editor and Publisher

http://www.photographybb.com
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Meet the PhotographyBB Team!
SNAPSHOTS OF THE CONTRIBUTING AUTHORS AND PHOTOGRAPHYBB ONLINE MAGAZINE TEAM MEMBERS

DAvE SEErAM is the Editor of the 
PhotographyBB Online Website, 
PhotographyBB Forums, and Editor/Pub-
lisher of the PhotographyBB Online Maga-
zine. Dave is also a digital photography 
and Photoshop enthusiast. 
PhotographyBB | Twitter | Facebook

John ogDEn teaches digital photography, 
Photoshop and Lightroom in the UK. 
Published author and award winning 
photographer, John is also an Adobe 
products beta tester and member of the 
UKs Royal Photographic Society
Portfolio | Books 

Jon AyrES is a digital photographer from the 
United States, now living in Moscow. He 
enjoys photography, writing, and history. 
Jon has been involved in writing, digital art 
and photography for over 30 years and is a 
published photographer and author.
Blog | Flickr | RedBubble

grADy LAyMAn is our resident portraiture 
specialist who always strives to create 
unique photographs. Never placing 
restraints on creativity, Grady enjoys 
hard work and collaborating with other 
creative people.
Portfolio

MIkE FryE is a talented photographer as 
well as avid blogger, flickrite, and social 
networking guru. Mike loves sharing 
knowledge, and showcasing talented 
photographers through his photography 
blog.
Blog | Twitter | Flickr

ChArLIE BorLAnD  is a US based commercial 
photographer. He has created award 
winning work for many Fortune 500 
companies and had his work appear in 
Newsweek, Sports Illustrated for Women, 
Outside, Mens Health, Snow Country, USA 
Today, Shape, and more.

JAy LIvEnS is a computer guy a heart who 
loves digital photography, working with 
Linux, and running his own personal 
blog. Jay is our go-to guy for all things 
technical relating to digital photography 
and computers.
Blog | Gallery | Blipfoto

JASon AnDErSon is an active photogra-
pher, shooting primarily with Canon 
gear. His philosophy about photogra-
phy is learning through the sharing of 
knowledge, and enjoys both the art 
of photography as well as his written 
pursuits. 
Blog | Twitter | Podcast

ChrIS STyLES (aka “Nobby”) is our forum 
moderator. Two years off retirement & 
proud grandfather to 2 boys, 4 girls, his 
interest in photography stretches back 
over 40 years, and really took off with a 
renewed passion since buying one of the 
first Hewlett Packard’s digital cameras. 
Chris now shoots with a Nikon D700.

grEg MCCoMSEy is our forum moderator. 
Born and raised in Pennsylvania, he now 
resides in Ohio after serving 20 years in 
the US Air Force.  Greg enjoys photogra-
phy as a hobby and the continuing learn-
ing process that goes along with it. 
Gallery | Flickr

Guest Contributors in this Edition:
Lawrence Dortch - Going Pro: The Photo-Preneur

http://www.photographybb.com
http://www.photographybb.com
http://www.twitter.com/photographybb
http://www.facebook.com/PhotographyBB
http://www.csace.co.uk/
http://www.blurb.com/books/1360183
http://jondayres.blogspot.com/
http://www.flickr.com/photos/jonayres
http://www.redbubble.com/people/bossman
http://www.frozenforever.com/
http://www.photocapm.com
http://twitter.com/fryeme
http://www.flickr.com/photos/photocap/
http://www.livens.org/
http://tmgphotos.com/
http://www.blipfoto.com/tmg
http://www.canonblogger.com/
http://twitter.com/CBJason
http://www.canonblogger.com/the-podcast/
http://gregmcc.smugmug.com/
http://www.flickr.com/photos/35696215@N04/


 PhotographyBB Online Magazine can now be read in

Apple’s iBooks Application!

Now we go where you go!

Now you can download the PhotographyBB Online Magazine and take it with you on the 
go! Thanks to the latest update in iTunes and the iBooks app for the Apple iPad, iPhone, 
and iPod Touch, now PDF documents can be imported into your iBooks application.

1) Download the PhotographyBB Online Magazine to your PC.
2) Connect your iPad to your computer with the USB cable. 
3) Fire up iTunes on your computer if it’s not set to automatically run.
4) In iTunes on the left side of the screen, click on “Books” under the Library menu.
5) Drag the PhotographyBB Online Magazine pdf document into iTunes.
6) Sync your iPad with iTunes, and your PhotographyBB Magazines will transfer to the iPad!

Now you can read PhotographyBB Online Magazine anywhere you bring your device. 
We are also working on a method for downloading the magazine into iBooks directly 
from the our website, so stay tuned for more. Happy reading!

If you are an Apple iPad, iPhone or iPod Touch owner, here’s how you can 
access the PhotographyBB Online Magazine library in your iBooks application:
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Confessions
of a PHOTOHOLIC

ARE PHOTOGRAPHy CLUBS WORTH yOUR TIME? - By Dave Seeram

Photography is one of those strange and rare 
animals which can be either a relaxing, creative-
outlet-type hobby, a specialty career or both. It 

can be a team sport, or a solo venture which takes you 
to all sorts of new and wondrous locations. Not only do 
you look at the world through your lens, you look at the 
world through your mind’s eye. Regardless of what type of 
photography discipline you enjoy, whether it’s your hobby 
or your, career, it connects all of us together through the 
threads of common interest.

When deciding what to shoot, be it professionally or 
personally, I am more than comfortable picking a time, 
place, subjects, or themes to photograph. I am used 
to working either alone, or with my own inner circle of 
friends and colleagues. I’ll be honest, I’m comfortable 
with the people I shoot with and the type of photography 
I enjoy doing. I’d never truly thought about seeking out 
photography clubs. I always figured that photo clubs were 
probably already a group of close friends, and I would be 
an outsider to them; not the best environment conducive 
to creativity. I do however, consider myself a social person, 
so when I was recently invited to attend a shoot being set 
up by a local photography club, I decided to accept the 
invitation and see what these photo-clubs are all about.

This particular event was being hosted by an 
established local photography club with several 
hundred followers on their Facebook page already, 
which is consequently where I received the invitation to 
attend. The club hired some models and makeup artists 
for the day, and had a planned shoot in the downtown 
Vancouver area - sounded like fun, so I signed up and 
attended the shoot.

When I arrived I was greeted by a welcoming small 
group of individuals, and had some great “getting to know 
you” type conversations while we waited for others to 
arrive. I don’t know why it surprised me so much, but as 
people started to show up, it was clear that many folks 
were coming alone and did not know another soul there 
at the shoot. This type of environment was actually great 
because it gave everybody there a chance to meet each 
other, and the club’s admin people did a wonderful job of 
keeping the conversations going.

Needless to say, the actual shoot itself was a blast, 

but for me the interaction with other photographers 
was even more fun. I met everyone from complete 
beginners to seasoned pros, all of whom seemed to be 
there for the exact same reason as myself - to get out 
and meet some other photographers while doing a fun 
shoot in the process.

Upon getting back from my first photo-club 
experience, I was inspired to investigate other local 
clubs and see what types of things are going on in 
the photography community. I checked out the club’s 
(which I attended) homepage and past events to find 
that not only do they host photo shoots, they also hold 
workshops, training sessions, and even social events 
like beach BBQ’s! Some (but not all) of the workshops  
are even free, which teach new shooting techniques 
mainly at the beginner level. 

What better way to enjoy photography even more, 
than to become part of a local photographic community. 
Of course, there are sure to be some regular attendees, 
but when clubs like this have hundreds of members, only 
handfuls of them are able to show up at certain events 
since everyone holds such a busy personal schedule. So 
socially, you’ll have a chance to interact more personally 
with different people with every event you attend. 

On the educational side, the benefits of being 
able to freely attend any given workshop of choice is 
simply great. Every photographer, from beginners to 
experienced professionals, has certain photographic 
disciplines they either want to improve on or learn 
from scratch. Attending a workshop hosted by a photo 
club will always be more affordable than taking a full 
blown course, and in some cases they are even free to 
attend! Additionally, photo clubs may have resources 
and access to materials such as a studio, lighting gear, 
and other equipment reserved for club shoots, which is 
a great way to get some basic experience with these 
things at little or no cost.

Making new, like-minded, friends and contacts, free 
or low-cost photographic education, and pre-arranged 
photo-shoots - these are some great benefits for any 
photographer and totally opened my eyes to the world 
of local photo-clubs. Are photography clubs worth your 
time? Absolutely.

This article is Copyright © and courtesy of Dave Seeram. Please contact the author directly with any questions.
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OLD “RE”-FASHIONED SOCIAL NETWORKING - By mike Frye

Social Media for Photographers
SOCIAL NETWORKING AND SELF-PROMOTION TECHNIQUES FOR THE PHOTOGRAPHER / ENTREPRENEUR

Over the course of the last seven months we 
have talked at length about social networking 
and several of the ways that photographers 

can connect online, present their work online, and 
market online. Last month we looked at one way to 
leverage your time with Facebook by using a Flickr 
application. This month let us look at another way 
that the photographer can use social networking to 
leverage their time.

We will not be visiting any websites, or 
recommending any specific on-line media this month; 
rather let us look at social networking in its purest 
form. Have you thought about ways to market your 
abilities, skills, and craft in person? I know it is a wild 
thought right?

That “social networking” might require one to 
leave behind their PCs, Macs, laptops, and handheld 
devices in order to network with others in person. 
However, this type of social networking will benefit 
you ways that online interaction may not. Let us take a 
look at couple of ways you can network, promote your 
work, and still use online social networking to support 
your photography.

The Interested
One of the ways that one can network with others 

regarding their photographic work is to get out there 
and shoot some photographs. Did you know that 
people are interested in what you are doing when 
you are out shooting? They may not approach you 

http://www.photographybb.com
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directly, none-the-less, there are those who are 
watching you and may be interested in what you are 
doing with what you are seeing.

Have you thought about approaching them and 
asking what they see in the subject that you are 
photographing? They are obviously curious about 
what you are doing, so allow them to share their 
perspective. By approaching someone this way 
they will react one of two ways. They will either be 
repelled by your inquiry, or they will willingly give 
you what they see.

If they give you what they see in your subject, 

your interaction with them may provide an opportunity 
to market your work. In turn it may provide you with 
a fresh perspective on your subject. Foremost, it 
connects you to someone that you do not know that 
may be interested in your work.

The Candidate
How many people do you interact with everyday 

that actually do not know that you are photographer? 
I’d be so bold and venture to say that everyone is 
interested in photography on one level or another. 
They either look at it or make it. Talking to those 
who are around you daily may open up avenues for 

Photo by: Dave Seeram

http://www.photographybb.com
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you to market, provide shooting opportunities, or 
even enhance the photographs you make through 
the exchange of ideas – communication – social 
networking!

Allow me a personal note on the matter of 
enhancing the photographs that one makes. I 
recently approached a beautiful young lady who I 
have interacted with daily for more than two years 
about modeling for me. She had no idea that I was 
photographer and, of course, had some questions 
about why I would want her to model for me.

One of the questions she asked was, “Why me?” 
I told her that she was very photogenic and that I was 
looking for someone to model for me who owned a 
Harley Davidson motorcycle. She and I had at some 
point discussed her interest in motorcycles and that 
had prompted me to consider a shoot involving her 
and her Harley. She had a few more questions, which 
I answered and our conversation led to an opportunity 
for me to market my photography and “pitch” the 
potential outcome of having her model.

Are you looking for that “candidate”, as a 
photographic subject, who you know that may be 
interested helping you market and enhancing your 
photographic work? The willing and happy participant 
can be one of the greatest verbal advertisers, 
marketers, which you can have regarding your skills 
and abilities with as a photographer.

The Point of Reference
We have looked at couple of ways to interact in 

the purest of forms for 
social networking; person 
to person contact. Now 
let us look at how you 
can use social media 
(online social networks) 
in your person to person 
encounters. There is 
one very straightforward 
method in getting people 
you meet or know to your 
profile page or online 
portfolio. Provide them 
with a point of reference 
that is tangible.

Do you have cards 
that have your social 
networking and contact 
information printed on 
them? Do you believe 
that The Interested would 

be interested in learning more about your work? Do 
you think that The Candidate you know might like to 
see the work that you have produced, so that they 
can share it with their friends?

Last year, a fellow photographer and I had 
an idea that involved this concept of providing 
something material. We decided to approach 
people on the street as we were out shooting, offer 
to take their photograph, and provide them with 
a business card. The business card gave those 
who wanted their photograph with a link to an 
introductory webpage with a short description of 
our photographic services and contact information. 
The webpage also provided a link to a Flickr Set 
that was set up for the person to download (for 
free) the images that were captured in our initial 
encounter with them.

The point is this; people need to be pointed 
to your photographic work and there is only one 
way to do that. Tell them about it. Your time can 
be leveraged by allowing people to market with 
you after a positive personal encounter. Social 
networking face to face is simply the best way to 
get the word out about your craft.

Using social networks online can assist you by 
enhancing the personal connections you have made 
with those who will want to learn more about you 
and the wonderful photographic work that you do. I 
know marketing in this way is so “old fashion”, but it 
is effective and effective is what every photographer 
should strive for in promoting their craft. Don’t be 
shy… Get out there, walk, talk, and then point!

Image by Filomena Scalise at FreeDigitalPhotos.net

This article is Copyright © and courtesy of Mike Frye. Please contact the author directly with any questions. Image credits as noted.
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The Good, the Bad, 
and the Ugly
in avoiding Photography SCAmS

by Jon D. Ayres

People have fallen pray to scammers since the 
beginning of time, when the first caveman 
in Europe tried selling another caveman a 

cave in a far away place, a fancy cave with indoor 
running stream water pluming and wind powered air 
conditioning in summer and volcanic central heat for 
winter.  Of course let’s not forget Victor Lustig who 
in 1926 sold the Eifel Tower to six different people.  
Scams are a fact of life, especially today if you use 
the Internet and have an email address.  There are 
scams and scammers for just about everything, even 
photography.  With the popularity of fully automatic 
digital cameras came a rush of people wanting to be 
pro photographers. It was not long until some clever 
opportunists noticed the growing available harvest 
of “photographers” and devised scams exploit them. 

What makes these scams even harder is that many 
are not illegal, rather playing on the photographer’s 
emotions and egos. 

It’s easy to fall for photography scams; I myself 
have been taken a few times.  What scams have in 
common (especially photography and writing scams), 
is that they tend to prey on a person’s emotions, 
egos, vanity and pride.  They inflate the target’s 
ego and vanity so much that they are automatically 
willing to buy anything, and many people do fall for 
this.  There are three types of photography scams 
that are the most common: contests, job offers and 
publications.  The first type, contests, really border 
on legality where as job offers are out and out theft, 
and the last involves publications which rip off 
photographers in many ways.

As far as photography contests are concerned, it 
really depends on one’s outlook as to whether or not 
they are scams.  What the contests do is a thin line 
between legitimacy and rip-off.  They are not exactly 
doing anything illegal, though I question whether or 
not these contests are actually ethical. 

I remember a while back, one very well known 
and respected publication would hold yearly photo 
contests, and the winners photos would be published 
in their magazine.  Of course most photographers 
would love to see one of their photos in one of the 
top magazines published all over the world, I sure 
would.  The trouble was that this particular publication 
took all rights from the photographer and they were 
free to use the winning photos in any way, including 
magazines, books, videos, calendars, anything 
without paying the photographer.  There was such 
an outrage by photographers that this magazine 
embarrassedly admitted it made a mistake and 
stopped taking the rights away from photographers 
who entered their contests. 

It’s pretty easy to tell a legit contest from a scam 
contest that either wants to take your photos or sell 
you something.  Most legit contests which give prizes 
have an entrance fee so that the prized awarded 
can be paid for by the entrance fee.  That’s not to 
say that all free contest are scams, but if they are 
offering prizes like cash or to be included in some 
fancy book, that’s a sure sign that there is a catch.  
Also, if the contest’s web page includes nothing but 
the contest, that’s also a sign that the contest is a 
rip-off.  Most legit contests are part of a promotion for 
a magazine, camera, product launches… something 
besides just a contest.

The second major photography scam involves 
job offers.  Somebody sees your online album (even 

http://www.photographybb.com
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from free photo sharing sites) and offers you a job; 
often photographing a close relative’s wedding.  I’m 
amazed by the number of people who fall for this.  
Here’s how it works: Somebody finds an online 
album and contacts the photographer by email.  They 
tell the photographer how amazed they were with 
the photos, the photos were just hypnotic, and they 
must have the photographer shoot their daughter’s 
wedding.  It makes no difference if the photographer 
has any wedding experience or not.  They simply 
must have that photographer at all costs; they will fly 
the photographer to some exotic location like Hawaii 
or the French Riviera and pay them some unheard of 
price to do the wedding photography.  Sounds great 
doesn’t it, but there’s a catch.  The photographer 
and make-believe client agree on a down payment, 
but the client overpays, so the photographer being 
honest tells the client about the overpayment.  The 
so-called client tells the photographer that his 
“secretary” accidently over paid.  The client asks 
the photographer to send him the refund by Western 
Union, sometimes as much as 2 or 3 thousand 
dollars.  Guess what?  The check is no good and 
bounces after a while, and the photographer loses a 
few thousand dollars for a scam job.

The last major photography scams are publications.  
A magazine editor sees your online photo gallery and 
wants to use some of your photos.   Other times you may 
enter a contest hosted by a magazine and the winner 
will have their photos published in the magazine; things 
are not always what they seem in publishing.  Similar 
to the “photo contest” type scams, some publications 
will claim ownership and full copyright of your work as 
included in their “fine print.”  

This is an important message for anyone who is 
new to photography. If you allow it, the cheapskates 
will exploit you. They want you to work for nothing, to 

buy tens of thousands of dollars worth of photo gear, 
show up when it’s convenient for them, finish on their 
schedule, format your images the way that they want, 
deliver your work immediately, and be happy that you 
only “got credit” for your many hours of hard work and 
hardware expenses. You will lose in the end. Credit 
for your work can be a good thing, as long as that’s all 
you were expecting to get from the start. The key is to 
be informed of all of the terms and conditions before 
submitting your work.

I am always incredibly flattered on the rare 
occasions that someone actually wants to buy 
a photograph from me, but I always ensure that 
somewhere in correspondence or invoice in writing 
that I stipulate that I own all rights to my photos; even 
when I don’t charge anything much, or anything at all.  
I often provide photos for free when I am doing work 
like for PhotographyBB Online Magazine which offers 
the magazine for free (and still lets me keep my own 
copyright), or for charities I support or believe in.  

Ultimately we all have the responsibility to protect 
ourselves from “smarter” cookies by remembering 
that if the deal sounds too good to be true - it 
probably is!  Scams are in the eye of the beholder; 
what I may consider to be a scam, others may not.  
Some photographers are willing to let a magazine or 
newspaper publish their photos just so they can see 
their photos in print, which really amazes me because 
there are many worthwhile charities and popular free 
publications like PhotographyBB where people can 
see their work in print without losing their photo rights.  
But as long as some people let their egos replace their 
common sense, they will continue to be ripped off.  I 
guess its human nature for us all.  Never rush into 
anything without checking everything out completely, 
always search the internet for info on the contest or 
publication.  Protect yourself with all the knowledge you 
can, and remember - scammers target the uninformed!

This may sound far-fetched to many of 
you, but it happens all the time.  These 
scammers often deposit enough 
money in a bank to cover the check, 
but then close the account before the 
check can be processed  There are 
several variations to these scams, but 
the one thing in common is the major 
tool of the scammer – letting praise 
go to the head of the photographer.  
Remember, if the offer seems too 
good to be true, most likely it is.

This article and images contained are Copyright © and courtesy of Jon D. Ayres. Please contact the author directly with any questions.
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The area of corporate and 
industrial photography is big 
business. Large corporations 

and small business’s alike must show 
the world their products, their people, 
and their manufacturing ability to earn 
their client’s business. For you to earn 
the business of some of these large 
companies, you must have an effective 
portfolio of images that illustrate your 
ability to photograph a wide variety of 
subjects and meet your client’s needs.

 
You may be asked to photograph 

an executive in their office or in the 
manufacturing plant. You may be asked 
to photograph in a high tech clean 
room or a coal mine. Being prepared 
for all possibilities is mandatory.

 
Photographic lighting for the most 

part is basically the same no matter 
the subject. You light one side of the 
subject, maybe fill in the other side of 
the subject to keep it from going dark, 
and then add accent lights for the 
finishing touches. 

If you photograph an executive in 
the studio or in the office, you still use a 
key light, fill light, and background light, 
and maybe some accent light such as a hair light or edge 
lights. If you shoot the same exec in a warehouse you use 
a key, fill, and lots of background lights. 

There is a vast array of lights and accessories that can 
be applied to your lighting equipment arsenal and each 
has a unique use or creates a different quality of lighting 
effects. In this article I will cover the basic equipment 
needed for corporate and industrial photography.  On 
some assignments you may be able to take all your gear 
while other times you may not, such as when you fly to 
the job. We’ll look at the equipment beyond your lights 
and its usefulness.

 
Light stands and booms:

You will need a light stand for each light and then 
several more to hold your reflectors, scrims, and more. I 

carry 16 light stands in two hard plastic golf cases to go with 
10 lights and various light modifiers. The smallest stand is 
12” tall and rise to 36” tall. These are primarily used when 
I need to hide a light behind something or place it under a 
prop and they also work well for background lights.  I have 
6 medium light stands that reach a height of 8’.  I use them 
primarily for putting lights next to subjects or when I need 
a light at an average height. The stands I use the most are 
the large, heavy duty light stands that rise to 12’. These 
stands are great for heavier light setups or when I need to 
put a light very high or bounce it off a ceiling.

 
Umbrellas:

These are probably the most widely used lighting 
accessories for industrial photography and have multiple 
uses. Umbrellas come with a variety of reflective surfaces 
and include soft white, soft silver metallic, silver, and 
gold. Your choice of umbrella surfaces is determined by 
the quality of light you would like to create.  A soft white 
umbrella will produce a soft, low contrast light, with soft 
edged shadows. A silver umbrella will produce a hard 

Selective LIGHTING for

            PhotographyCORPORATE &
INDUSTRIAL

by Charlie Borland

Equipment for Location Photography
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light with more contrast and hard edged shadows. The 
size of the umbrella also affects the highlight/shadow 
relationship when measured at a sett camera to subject 
distance. A small umbrella will create a smaller spread 
of light creating more contrast between highlights and 
shadows while a larger umbrella will have less contrast 
between highlights and shadows. The advantage to 
umbrellas is that they throw light everywhere and you 
often want light to spread far and wide.

 
Light Boxes:

This lighting accessory also comes in a variety of 
sizes from extra small to extra large and can be custom 
built for very large product needs, such as cars. The size 
of light spread and highlight needed for your subject will 
determine the size of light box you should use.  Light 
boxes, also called Soft Boxes, produce soft light similar 
to umbrellas. But because the box is enclosed and has 
an abrupt edge, the light spread is much more, narrow 
than an umbrella. This is helpful for controlling the spread 
of light on subjects and backgrounds. Keep in mind that 
different manufacturers make their box sizes different 
than each other. One company’s large may be bigger or 
smaller than their competitor’s.

 
Grids:

Honeycomb grids are used for creating a focused light 
from your strobes and are very effective for specific lighting 
approaches. These come in a variety of sizes, each 
creating a different degree of light spread. They work well 
for backgrounds, creating small highlights on products, or 
creating a light shape.

 

Grids can be used to accent products with an edge 
light, a hair light for a portrait, a narrow splash of light down 
a wall or background. They are a very handy tool to make 
your creative lighting look the way you want.

 
 The image (bottom-left) illustrates a great use of 

the grid. First, the idea for the photo was the process of 
testing parts using a CMM machine. I wanted to highlight 
that so I used an umbrella behind the setup angled down 
to create this reflection on the surface of the table top. 
Next, I added a grid on the left to light his face so none 
of that light would spill over the table top which would 
happen if I used an umbrella. On the right and rear, there 
is an umbrella with a blue gel creating that blue color on 
his back and the computer. I am also zoomed in tight to 
hide the distractions in the background.

Lights:
I have both studio strobe power packs, where the 

light head plugs into the power pack, and mono lights, 
where each light is the power pack and strobe head in 
one package. I use the power pack and heads when in 
the studio or location, and when I need lots of power 
output. My preference is mono lights because they 
are small and compact and are easy to fly with if the 
assignment is on location.

Also consider battery powered strobes as well for 
situations where you might not have access to electrical 
power. They work wonders but often the batteries only can 
sustain 1-2 locations before needing recharging. When I 
am indoors I stick with the more powerful AC strobes. 

  

This image (above) is a great example of finding a 
visually exciting composition but an area with no power, so 
I used a Norman 400B battery powered strobe to light him.
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You should be concerned and careful about how you 
pack your lights for transport. Because I do so much on 
location, I decided to use the Pelican 1650 cases, one of 
the biggest they make. I can get 5 lights, reflectors, spare 
tubes, cords, grids, and more in each case. The reason 
I went with these is they are airline proof for the most 
part. The cases that come with many lights are great for 
moving around, but get destroyed on the airlines. Carefully 
research how you pack your equipment.

 
When I am flying I do a couple things: remove the 

modeling lamps and wrap them in bubble wrap and it is 
because they will break from the vibration. I also stuff 
bubble wrap around each light for a little softer padding. 

 
Grip Case

I also use another older Pelican case for what is called 
the Grip Case. In this case are extension cords, clamps, 
black sheets, tools, duct tape, straps, barn doors, rags, 
ceiling clamps, screwdriver, wrench, and other odds and 
ends. This case is always packed and really is designed 
for shooting on-location and contains everything I might 
possibly use and so I don’t forget everything. In the studio 
I open and use as needed. When flying with this case it 
is substantially overweight and there will be severe airline 
charges for this, so I often pick through the grip case and 
select only what I feel is absolutely necessary for the 
location and pack it elsewhere. 

One of the most useful tools is the lighting panel. 
These panels come with various materials that you can 
attach the frame. I have white diffusion, black, highly 
reflective white, moderate reflective white, gold, and 
silver. Without a doubt the most useful is the diffusion 
material. Here I shine a mono light through the panel and 
it creates a much bigger light box. 

 

What modifier to use?
You should carry a variety of light modifiers with 

you including umbrellas, light boxes, panels, and grids. 
All of these control light in various ways and the choice 
on which light modifier to use depends on just what you 
are photographing. If for example, I am photographing a 
group of six people standing in front of the big machine 
the company builds, I will use a large umbrella because 
it throws light everywhere. That light will not only light 
the people, but also the machine and the floor as well 
producing a nice coverage across the group.

Now the client asked me to shoot just the CEO in front 
of the machine and my approach is to make him brighter 
than the machine so he visually stands out. I choose a 
light box this time to light the CEO nicely but not have any 
light spill on the machine since I can light it separately with 
lights that won’t spill onto the CEO. 

Lighting Strategy
To determine the best approach to lighting your subject, 

consider a few ideas. I feel that every photo for the most 
part has a ‘star’ in the picture. If you are shooting a portrait 
then the person is the star and you will light them as the 
star.  A machine operator in a factory may be the star, or 
the machine they are running is the star and might be the 
reason the client asked you to shoot it. In this case with the 
machine being the star, the person is often a supporting 
element and is strategically placed as a compositional 
element showing scale. 

The best approach is to determine a good angle for the 
image to be photographed and this will depend on whether 
or not there is an operator and where that operator is 
positioned. It is best to photograph the operator at an angle 
where you can see the face, straight on or from one side. 
I never shoot backsides of people unless there is a strong 
reason to do so. Viewers want to engage with the operator 
and see what they see so to speak. 

Using Color
Many situations that I am asked to photograph for 

business and industry are what I describe as; ugly, dirty, 
boring, drab, etc. These locations are usually business or 
manufacturing plants that have no color to them. I like to 
use color by gelling my lights and you can literally hide 
the ugliness of a facility by covering up the blandness with 
color. You can get these colored lighting gels from any 
distributor of Rosco gels and most major camera stores. 

Packing Your Lights

The Light Panel



Pa
ge

 1
5 

 
w

w
w

.P
ho

to
gr

ap
hy

BB
.c

om

In the above image, I was photographing a new 
manufacturing plant in Mexico and the building was sparsely 
furnished. The strategy was to zoom in with a telephoto 
lens as this minimizes how much of the surroundings show 
in the picture meaning I only see a small section of the 
blank concrete wall in the background. I then lit it with a 
green gel which hides the sparseness even more. I used a 
light box on the left to light them, and an umbrella from the 
right with a red gel for an accent light.

I carry with me most colors from blue, to red, green, 
cyan, magenta, yellow, purple, and pretty much all 
common colors.  Which color should you choose for a 
photograph? The main thing to remember is that Warm 
Colors Advance, Cool Colors Recede. Think of it this way: 
you are photographing a portrait of someone and you 
place a blue gel on your key light and an amber gel on your 
background light. Their face is blue and the background 
is warm amber. Does that look weird? It does, so instead, 
put a warm gel on the key light and a blue gel on the 
background light and that looks more realistic, like the 
person is lit by sunset light against a blue background.  

   
This image (right) is from a factory that makes drive 

shafts and the process here is pretty thin on interesting 
aspects and had lots of space around it. To make it 
interesting I placed a 250mm lens on camera and 
backed up, using that telephoto compression to stack 

the subject for more interest. I placed a large light box 
on the left to light him, an umbrella on the right to add 
an edge light on him and show more detail. A raw strobe 
head with a green gel was hidden behind him to light the 
rear wall, and one more light on the right with a magenta 
gel to color the oily floor. 



Pa
ge

 1
6 

 
w

w
w

.P
ho

to
gr

ap
hy

BB
.c

om

Some of the subjects you are asked to photograph will 
require you to use your strobes with the available light in 
your photos while others will be shot using only your artificial 
lights. Available or ambient light is what exists whether you 
are there or not. It could be sunlight, a streetlight, indoor 
lighting, or any constant light that is available whether you 
are photographing or not. 

Sometimes you need to use the ambient light mixed 
with your strobes and sometimes not, but the deciding 
factor is often whether you have enough strobe lights to 
light the whole scene or not.  The main rule to remember 
is: shutter speed controls the ambient light and f/stop 
controls your strobe exposure. The best way to remember 
this is when the strobe or flash fires it is an instant spike 
of light, so it matters not whether your shutter speed is 
1 second or 1/100, that spike happens quickly while the 
shutter is open. The f/stop on the other hand controls the 
strobe exposure.  When you adjust the f/stop you are 
allowing in more light or less light simply by changing 
aperture. This rule once understood allows you to adjust 
your ambient light (shutter speed) and your strobe light 
(aperture) with simple adjustments. 

 
Depending on the shot you need to get, you may 

choose to use ambient light or not, but you need a clear 
idea of why you would want to choose one option over the 
other. If you are asked to go into a company and photograph 
3 executives for a press release and they ask you to set 
up in the meeting room, you already know you do not need 
the ambient light. How do you know this? Because your 
setup is routine for the most part: a light large modifier 
big enough to photograph 3 people as the key light, a fill 
light over the camera, a background light on your canvas 
background, and possibly a hair type light if you can make 
it work for three people. So do you need ambient light? No!

 

Now you are going into a factory to shoot an operator 
on a large punch machine, making parts. The client is with 
you and tells you what they want to see and you set up the 
shot from the camera angle the client asked for. How big 
of a scene is it? Do you have enough lights to easily light 
the whole area? Do you need to use ambient light to fill the 
dark areas where your strobes are not reaching? You may 
need to but remember the trade off; if ambient light fills in 
dark areas it also is lighting your subject.

   Occasionally the scene is too big to light based 
on the chosen composition, requiring more strobe lights 
than you may have, so you are forced to use the available 
lighting as part of your lighting. In the case of this example 
(bottom-left), a strobe was placed inside the machine to 
light the operators face. An umbrella was placed to the 
right to light his back and add that blue to the side of 
the machine. The rest of the lighting was the ambient 
overhead lighting which turned out amber in color based 
on the daylight settings on the camera. 

In this image (above) the idea was to photograph 
‘pump repair’. To create a strong composition I wanted 
the pump and operator further from the wall so that I could 
light the subject and the background separately. Being 
able to do so is a powerful technique for building strong 
images where you can light the background to be darker 
or lighter than the subject, allowing either approach for 
the subject to really standout. I placed a light box on the 
left to light him and turned it away from the wall to prevent 
light spill on the back wall. I placed another light box on 
the right with a yellow gel to add an accent to the parts 
and him. Then I added two umbrellas, one left and one 
right, with light blue gels to light the background. 

Ambient Light: To use or not to use?
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Your ability to do that is what will have clients hiring you. These clients may walk by a certain process in their plant 
everyday and see the same thing and then hire you to make it look really good. They often say “I don’t know what you are 
going to do but can you make it look good?” and that is your job, to dig something out that is visually strong and exciting and 
makes them say “I have never seen that before!”

 
This woman works at 

an ‘industrial’ table that is 
sparse of any detail. Behind 
her is a wall that is a drab 
color and flaking paint. There 
is nothing here exciting at all, 
so I had to come up with a 
strong image. She normally 
works on these parts like she 
is here but to make a more 
exciting composition we slid 
in one more part from the left 
to create a frame. With the 
150 mm lens set to f/4 there 
was very shallow depth of 
field and that made it more 
interesting as it forces the 
viewer to look at her. We 
placed a large light box to 
her left, and added a cyan 
colored gel to the background 
light on the wall in the rear.

The main thing to 
remember is that you have 
a star in the photo and you 
have to decide what lighting 
approach will best make 
that star standout? You can 
light big with umbrellas that 
throw light everywhere but 
that sometimes results in 
flat lighting. Instead use light 
boxes to create soft even 
light on the subject and then 
add grids and more light 

boxes to selectively light, placing light only where it creates an effect, followed by using a little ambient, underexposed 
some, to add detail in the remaining areas. 

You can hide ugly areas by using telephoto lenses at wide apertures to zoom in on selected areas of the scene. Use 
opposite colors; if you use a blue colored light on the background use warm colors on the subject. And remember the most 
important consideration of all - Tell the clients story with your photography!

About Charlie Borland:
Charlie Borland has been a commercial photographer for 30 years and has completed many award winning annual 

reports, corporate identity, and photo assignments for such clients as IBM, Siemens Westinghouse, Texas Instruments, 
Nike, Xerox, and more. Charlie Teaches lighting courses at the Perfect Picture School, www.ppsop.com, and Aspen 
Photo Workshops www.aspenphotoworkshops.com. 

Making Something From Nothing

This article and all images contained are Copyright © and courtesy of Charlie Borland. Please contact the author directly with any questions.

http://www.ppsop.com
http://www.aspenphotoworkshops.com
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We’ve just had a look at various lighting options as they relate to industry and environment, and in this article 
we will focus on the quality aspect of lighting as it relates specifically to portraits. We will be looking at 
several different modifiers side by side. This way you can study the effects from each modifier. I will also 

be explaining how to test your own gear. If you can understand the capability of your lights then you will be able to 
make better decisions before you start shooting.

The lighting set up:
All of the images in this article were shot with the same lighting set up. The model is five feet in front of the 

background. There is only one Key light used so we can accentuate the effects for each modifier. The Key light is 
five feet away from the model and placed at a 45° angle. The flash head is raised about six feet off the ground. The 
camera is sixteen feet in front of the model and shooting down at a slight angle. Here is an overview diagram of the 
lighting set up. 

 

HOW TO MODIFy yOUR LIGHTING:  By Grady Layman

Portraiture Photography 101
TIPS AND TECHNIQUES FOR PORTRAITURE PHOTOGRAPHY AND LIGHTING

In the art of photography there are two different approaches to lighting your images: 
naturally and artificially. If you are a “natural light” photographer then you are always 
looking for the best quality light that nature can provide. This method can limit when 
and how you shoot your images. However, if you learn to shoot with artificial lights 
then you will have more control over the quality, time, and location for all your images.

http://www.photographybb.com
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Shooting Bare
Whenever you use a strobe/flash without a reflector or modifier, then it is considered to be a bare light. Bare 

light sources are typically harsh and create sharp transitions between the shadows and highlights. The smaller the 
light source, the harder the light will appear. You can see in the below image that the hot-shoe flash is more harsh 
than the larger studio strobe. This is because the flash tubes on the studio strobes are larger than the flash tube on 
the hot-shoe flashes.

Typically I do not use hard light sources when shooting female models. This type of light can accentuate 
wrinkles, bags, and other blemishes. However, hard light sources can play important roles in shooting portraits. This 
is a perfect light source for shooting athletes, men, old farmers, and much more. Hard lights can also help create an 
edgy and dramatic feel that softer light could not achieve. 

Reflectors
Most studio strobes come with a reflector that helps focus the direction of the light. Reflectors can come in all 

different shapes and sizes. They also increase the effective output of the strobe by utilizing all of the light and re-
directing it towards your subject. 

I used two different reflectors in the below image. The image on the left is a standard 7” reflector that spreads a 
wide beam of light. Although the light source is now around 7”, it is still considered a hard light source. 

The image on the right is an 11” reflector which is also called a long throw reflector. This reflector has a deeper 
bowl and focuses the light into a smaller beam; thus, increasing the distance that the light travels. This extra 
distance makes it a good option for some sports photographers. I like the long-throw reflector because it helps 
control extra light from spilling onto the background. I don’t use either reflector much as a Key light. However, I do 
like to use them both for fill, rim, hair, and background lights.

Silver Umbrellas
Umbrellas are a nice, cost effective way to increase the overall size of your light source. You can bounce both 

hot-shoe flashes and studio strobes into umbrellas. Silver umbrellas are very reflective, therefore majority of the 
light bounced into the umbrella will return toward the subject.  Unfortunately, the reflectivity of the silver umbrellas 
also creates a directional light, which in turn creates stronger specular highlights. Most often, these highlights 
appear on the cheeks, nose, and forehead as bright spots of light. If your subject has oily skin then this will be even 
more noticeable. 

http://www.photographybb.com
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Silver umbrellas do have there benefits. A lot of photographers like to use them for large group shots. They work 
well when you need to light the inside of a large area. They also work well with small powered flashes and strobes 
because of the reflectivity.    

The image below shows the difference between a 42” silver umbrella and a 64” silver umbrella. Take a close 
look at the background and you will see that the 64” umbrella creates more gradient towards the corners because 
it has a flatter curve than the 42” umbrella. The 64” umbrella also has more direction than the 42” umbrella. The 
smaller the radius, or deeper curve, the more light will scatter in different directions and thus spilling light all over 
your background. 

Take a look at the shadow side of the arm. You can see that the light does not wrap around the arm as much as 
the 42” umbrella. Being a larger light source, the 64” umbrella creates softer light.

White Umbrellas and Shoot Thru’s
White materials naturally have a diffuse property, so it’s easy to say that white umbrellas create more diffused 

light than silver umbrellas. However, what does this mean when it comes to your portraits?  Well, to begin, the 
specular highlights from a white umbrella are less noticeable when compared against the silver umbrella. That 
means less shiny reflections on the cheeks, nose, and forehead. The light that comes from a white umbrella tends 
to scatter in more directions. Again, this creates softer transitions between your highlights and shadows. Even 
though the 36” white umbrella is smaller than the 42” silver umbrella it is still a softer light source, due to the diffused 
properties of the white material. Any time you can bounce light off white material it will make your light appear softer. 

The 36” shoot-thru umbrella is a lot like bouncing your light into a white umbrella. However, there are a few 
differences. Light that is pushed through a shoot-thru umbrella will not only travel through the material but also 
bounce back away from your subject. This spill can be hard to control and can sometimes cause lens flare, depending 
where the camera is set up. The other down side is how much power is lost when using a shoot-thru compared to a 
silver umbrella. On the other hand, you can compensate for power loss because shoot-thru umbrellas allow you to 
work much closer to your subject than traditional bounced umbrellas. The other benefit to light scattering is that it will 
now wrap around your subject better. Again, this will create a smoother transition between highlights and shadows. 
Shoot-thru umbrellas are one of the most cost effective ways to create soft light. They work well for shooting a wide 
range of portraits when used both as a Key light or a Fill light. 

The image below shows both the 36” white umbrella (bounced) and the 36” shoot-thru umbrella side by side. 
Look at how the shoot-thru creates more gradient on the wall as the light starts to fall off faster. Again, this is due 
to the loss of power from scattering light. If you look at the “bounced” photo you will still see a slight gradient on the 
background but the light is falling off at a much slower rate. 

http://www.photographybb.com


Pa
ge

 2
1

PhotographyBB Online Magazine www.PhotographyBB.com

Softboxes
The quality of light that comes from a softbox works extremely well for portraits. The light quality is very even 

and smooth. The light travels in one general direction due to the front of a soft box being flat, unlike a curved 
umbrella. This directional light also cuts down on the amount of light that typically spills onto the background. Also, 
because the fronts of softboxes are flat, they can be placed close to your subject. However, the larger the softbox 
the deeper the box needs to be. This can pose some problems when you are working in small studios or offices. 
Softboxes cost more and also take more time to set up than an umbrella. They can be used to light anything that 
requires soft diffused light. 

Strip lights are a lot like softboxes but are not nearly as wide. This helps to produce a strip of light that can run 
horizontally or vertically. Strip lights are typically used as fill, hair, background, or rim lights. However, I enjoy using 
them as the main light from time to time. They create soft light that is directional. The transition between highlights 
and shadows are both rapid and smooth. Strip lights are inexpensive compared to softboxes but will require about 
the same amount of set up time.  

The image below shows a 20”x30” softbox on the left and a 12”x30” strip light (shot vertically) on the right.  
Again, it is clear to see that the background has less spilled light when using the strip light. Take a close look at the 
shadows on the arm and you will see that the strip light does not wrap around the arm like the softbox light does. You 
can rotate most softboxes and strip lights to control where the light will wrap around your subject.  If I would have 
shot this image with the strip-light in the horizontal position then the shadows on her arm would transition slower.

Octaboxes
Octaboxes (or Octabanks) are exactly like softboxes except they are shaped like an octagon. This round shape 

produces a very nice gradient as the light starts to fall off around the edges of your image.  I really like to use this set 
up when I am shooting wide angles and the light is hitting the ground. They also work well when used on backgrounds. 
However, most people use them as a fill light or as a key light. Octaboxes will vary in size and price, much like a softbox. 
What I like most about Octaboxes is that they produce a round, natural looking catch light in your subject’s eyes. 

 
In the below image there are two octaboxes used: on the left is a 20” octabox and on the right is a 64” octabox. 

The smaller the octabox, the harder the light will appear. The 20” octabox will still produce soft light as long as it is 
placed within five feet of your subject. The 64” Octabox can be placed much farther away from your subject and still 
give a soft, diffused light. This can really help when you are shooting wide angles and don’t want your strobes in 
the frame. The other benefit to a large octabox, or softbox, is the ability to shoot full body shots and illuminate the 
entire body. If you were using something smaller, such as the 20” octabox, then you would only be illuminating the 
head and part of the torso. 

http://www.photographybb.com


Pa
ge

 2
2

PhotographyBB Online Magazine www.PhotographyBB.com

Snoots and Grids
Snoots and grids work along the same principle, limiting the spread of light and controlling spill. Snoots only 

allow the light to pass though a small opening and look like a long tube on the front of your strobe. This creates a 
very narrow beam of light that is very harsh and directional. There is almost no light that spills onto your background. 
A snoot works very well for product photography. When used with portraits it is typically used as a hair, rim, or 
background light. 

Grids are basically the same as a snoot except they use a honeycomb pattern to narrow the light beam. Grids 
are thin and attach to the front of your strobe. They also come in different grid pattern degrees (10°, 20°, 40°, 60°) 
that effect how large or small the beam of light will be. Again this is a hard light source and does not typically work 
well as the main light for portraiture. However, just like a snoot, it works well as a hair, rim, or background light. Keep 
in mind the closer you place a grid to your background the smaller the light beam will be. 

The image below shows the snooted light on the left and the 20° grid on the right. You can see how the snooted 
light basically only illuminates the model’s face, then immediately starts to fall off with no light has spilling onto the 
background. The grid illuminates the model’s face and spills very little light onto the background (bottom left of the 
frame).  Both modifiers have very strong, dramatic transitions from highlight to shadow.  

Barndoors
Barndoors are an easy way to control spill from a normal reflector. They have four doors that are independently 

adjustable and can be opened or closed. These doors can be closed to block, or flag, light from spilling into different 
sections of the frame. Again, this light will be a hard light because we are only blocking light coming from a standard 
reflector. Barndoors work well when used as rim, hair, or background lights. I have used Barndoors as a main light 
source for portraits but you have to be creating a specific look. The portraits I shot were very dramatic and I wanted 
to limit a small strip of light down the front of the models face.  

The image below shows two options that you can do with barndoors. The vertical image on the left was created 
by closing down both vertical doors and limiting a vertical strip of light. You can see how much light is being flagged 
from the right side of the background. The image on the right shows the barndoors used horizontally. This was done 
by opening the two vertical doors and closing down the two horizontal doors. These doors don’t get closed all the 
way but enough to limit the amount of light. You can see the top and bottom of the frame are starting to fall off, which 
creates a nice vignette look. 

http://www.photographybb.com
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How to study your own gear:
When I am testing my photography gear I like to run controlled experiments. In order to do this you have to 

control your environment. My controls were: the location of my model, lights, and camera. The only variable was 
what light modifier I was using. I was also shooting in a room with dark walls that would not bounce additional light 
(very important). I waited until night time so I wouldn’t have any ambient light coming through windows. The camera 
exposure and white balance were kept the same to better illustrate subtle changes in the modifiers fabrics. Each 
modifier was metered and the strobes output was adjusted to keep the camera exposure the same for every shot. 
The camera was placed on a tripod so it was always in the same position. I even attempted to keep my model as 
still as possible, as this would change how the light falls on the subject. You can use a mannequin but the light will 
always look a little different on real skin. 

“Light” is your variable - control it! 
Once you have your controls in place then you can start experimenting with your variable. I like to keep a list 

next to the camera this way I can record what corrections were made for that frame. The chart below was created 
to show the different effects of each modifier side by side. However, I also like to run independent tests for each 
light and each modifier. 

For example, if I was testing how my snoot would look as a background light, I would shoot several different 
frames. Each frame I would only move the snooted light to a different location. The snooted light would be the 
variable because it’s the only thing that changes each frame. If you make one adjustment at a time then you can 
better analyze what each movement does. 

Now if I was testing out a new softbox, I would start by testing it as a main light. Again, I would keep everything 
as still as possible while I only moved the one light into different positions. I would then also run the same test using 
the softbox as a rim light.

Knowledge is... Control!
The more knowledgeable you are about your own equipment, the more you will be able to utilize each piece 

effectively.  Knowledge is the key to problem solving when you are in the middle of an important shoot. These tests 
will take a little time upfront but they will pay off in the long run.

This article and images contained are Copyright © and courtesy of Grady Layman. Please contact the author directly with any questions.
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home networkby Jay Livens

One of the challenges for a photographer is identifying 
the most efficient method to store and archive images.  
This is particularly difficult since image sizes are constantly 
growing and so a solution is needed that can expand over 
time.  The other challenge is that many photographers have 
multiple computers and a system is required that allows the 
storage to be effectively shared across computers.  The 
obvious solution is a reliable form of shared storage and in 
this article we will discuss the common options and pitfalls.

Implementing shared storage is not as hard as it 
sounds.  However, before discussing the technology in 
detail, it is important to clarify the term.  I’ll define shared 
storage as a solution that allows multiple computers to 
access the same data simultaneously.  The definition is 
purposefully created to exclude the practice of moving a 
USB hard drive from one computer to another.  USB drives 
are not optimal for sharing and the constant movement 
and plugging/unplugging could lead to reliability problems.  
The method covered here relies on proven technology that 
is designed for robust file access and risk avoidance.

The simplest method to share home files is to use a 
technology called “Networked Attached Storage” or NAS 
for short.  NAS solutions allow the sharing storage of 
resources over a home network (AKA a LAN) and they 
are typically mapped to a drive letter on a system.  NAS 
technology is often used in business environments and if 
you access something like a “Z drive” or “Y drive” then you 
are most likely using this technology.  These systems are 
agnostic to the type of network and computer OS.  They will 
work equally well in Windows, Mac or Linux environments 
and with wired or wireless networks.

Network connectivity is an important consideration with 
NAS.  Wireless networks are common today.  However, 
wireless performance specifications are often overstated 
and this will impact your NAS performance since data 
access speeds depend on available network bandwidth.  
My recommendation is to use a traditional wired network 
connection for both the system housing the storage and 
the one accessing the storage most frequently.  The faster 

the wired connection the better and I encourage the use 
of Gigabit Ethernet (the fastest form of mainstream wired 
Ethernet) wherever possible.  Note that wireless access 
will work fine, but speeds may be slower than desired.

When implementing a NAS you should remember 
that centralized storage comes with risks.  It is great for 
sharing disk capacity and files, but represents a central 
point of failure.  If a hard disk fails in your NAS then you will 
lose all of your stored data which could be catastrophic.  
I strongly recommend using a RAID based solution to 
protect yourself from a single disk failure.  At the very 
least, you should backup (AKA create a copy of) your NAS 
share on a different storage system. Many home based 
NAS hardware solutions come with the available drive bay 
space to implement a simple RAID based solution.

Implementing a NAS infrastructure is not as hard as it 
sounds and there are two common ways to do it.

Windows Based Computer
A standard Windows computer can provide NAS 

connectivity through the computer itself (as opposed to 
purchasing a standalone NAS device).  The system can 
share any attached storage including internal hard drives 
and external USB hard drives.  To use this method, attach 
the desired storage and then create a folder inside the new 
storage volume.  Perform the following steps to enable 
connectivity in Windows XP. Microsoft explains how to 
enable this functionality in Windows Vista and Windows 7):

1. Right click on the folder and choose the “sharing” tab
2. Choose “share this folder”
3. Click on “permissions” and enable read/write access for 
everyone
4. Click apply

The process of accessing the share requires you 
to use a remote system on your LAN.  First double-
click “My Computer” icon and enter something like 
\\192.168.30.1\ into the address box.  You must replace 

Implementing a shared storage infrastructure

How to SHARE YOUR PHOTOS
      over a personal

http://www.photographybb.com
http://technet.microsoft.com/en-us/library/bb727037.aspx
http://windows.microsoft.com/en-us/windows7/Share-files-with-someone
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“192.168.30.1” with the IP address of the windows 
system that is configured for sharing.  You can find 
detailed instructions on how to find this information 
for Windows XP, Vista and 7 here.

The above process sounds straightforward, but 
in my experience can be complex.  I often run into 
permission issues and find configuration difficult.  The 
other challenge is that a typical Windows computer 
may not offer RAID protection and so you must be 
sure that you backup the computer frequently using a 
system like Mozy or Crashplan.

Dedicated NAS Device
My preferred approach is to use a dedicated NAS 

device.  These are storage systems that are designed 
exclusively for NAS access.  They often include 
advanced features like RAID technology and the ability 
to grow available storage.  These solutions are more 
expensive than reusing existing home computers, 
but are available from a range of providers with the 
smallest ones costing around $150 and expensive 
units supporting 4 or more drives costing $600+.  
Larger and more expensive units typically provide 
faster performance and greater expandability.  When 
selecting one, you should ensure that it supports 
RAID1, RAID5 or RAID6 which will provide the 
appropriate level of protection.

The other benefit of dedicated devices is that 
they typically offer wizard based configuration and 
management through a web interface.  Additionally, 
most systems support RAID for added levels of 
performance and reliability.  (Note that your NAS box 
must have at least 2 drives to support RAID.)  They 
also offer simplified security with the ability to create 
separate usernames and passwords for each volume 
that you want to share.  (Note that Windows can 
provide the same authentication, but it can be more 
challenging to implement.)

You would use the same process as described 
above to access the dedicated NAS device once 
you have it initially configured, and the NAS will be 
accessible from both PCs or Mac computers.

In conclusion, shared storage provides strong 
benefits to photographers, allowing multiple family 
members access to photographs stored in one 
location.  The ability to centralize image storage on 
one device is very powerful and is easier to implement 
than many imagine.  It simplifies the organization of 
your images and disk capacity.  However, you should 
strongly consider a RAID-based solution to ensure 
that your data is protected in the case of a disk failure.  
Additionally, regardless of your storage infrastructure, 
you should be backing up your data nightly to protect 
from data loss or corruption.

Example of a standalone Network Attached Storage (NAS) system. Photo courtesy of Linksys by Cisco

This article is Copyright © and courtesy of Jay Livens. Please contact the author directly with any questions. Image credits as noted.

http://www.photographybb.com
http://kb.iu.edu/data/aapa.html
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How and WHEN to

BREAK THE Rules 
in Digital Photographyby Jason Anderson

Drive right!  Pass left!  No smoking!  Wear your seatbelt!  Back up your data!  Everyone has heard these before – they are 
rules that we are expected to follow.  The same holds true in photography, but with one important caveat – in photography, 
the “rules” aren’t as stringent.  You can break them from time to time and really get some fantastic imagery.

When it comes to making suggestions on how to improve your photography, I am usually at the front of the line when it comes to 
suggesting that we follow the rules.  The reason I say that is because the “rules” tend to be there for a reason – they work!  Or, more 
accurately, they work most of the time.  Yes, that’s right, sometimes the rules are indeed meant to be broken.  The important thing 
to understand is that you shouldn’t just eschew the rules for the sake of “being different”, or “because you can.”  Quite the contrary; 
most photography that doesn’t work for some reason or another is because it doesn’t adhere to a rule or guideline somewhere.  

To be honest, I follow the rules of photography the vast majority of the time.  In fact, breaking the rules is tough do to because 
the rules so often will enhance your photography more than breaking them will.  For this reason, I’ve always held the belief that it’s 
important to not only follow the rules of photography, but to understand why the rules work in the first place.
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Today, I’d like to explore three of the most basic rules of composition – 
the ones that literally will make 9 out of 10 images really great, and explore 
why the rules work.  In understanding why the rules work in most cases, we 
can then make the leap from using the rules to eschewing the rules, and 
capture a compelling image or two by breaking out of the mold.

Probably one of the most fundamental rules in photography is that of 
the Rule of Thirds (often abbreviated simply as just the ROT).  Quite simply, 
the rule of thirds says to position points of visual interest on particular 
lines within an image.  When you compose your images either in camera 
(preferred) or through cropping in post-production, these points of interest 
will fall onto either a horizontal or vertical grid of lines.  (Think of a tic-tac-
toe board).  If a person is standing in a picture, you would want to place 
them on one of the vertical lines of the grid.  Further, if you are making a 
picture of a landscape scene, the horizon would best be positioned on one 
of the horizontal lines.  Most of us understand this, and accept this as just 
how things work.  But we miss considering really asking “why” it works.  For 
those who have kept up with my writings, you know I love to ask why, so 
let’s just dive right in since the water is warm!

The reason I think positioning things on the grid works is because it 
creates a sense of space.  It brings your eye through an image. Take the case 
of the gas flames I captured from my archives included.  Each of the flames is 
on or near one of the third marks on the grid.  This takes the viewers eye from 
the first, to the second, and then the third before leaving the image. 

Another example could be something as simple as a building ornament 
and its shadow.  Strategically placing the ornament near one of the cross-
marks where thirds intersect can create visual appeal and give the viewer 
something to lock in on. 

The photography of bridges is another great way to demonstrate the 
effectiveness of the Rule of Thirds.  Arches and supports positioned on or near 
the marks provide a great way to lead the viewer through the image!  Clearly, 
defining the space using the Rule of Thirds can be a very powerful tool.  

So, in seeing and now understanding how and why the ROT works, let’s 
now look at ways in which we can break out of this mold, and come up with 
a compelling image or two that makes its own set of rules.  In particular, one 
that stands out from my own repertoire is one that completely takes the rule 
of thirds and turns it on its head with a circle and spokes!

The Rule of Thirds
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Images with circular or angled 
lines serve as great examples of 
when the Rule of Thirds can be 
completely broken.  Quite simply, 
the subject does not lend itself 
toward aligning within those vertical 
or horizontal lines, and the image of 
the window trim is a great example 
of how breaking out of the mold can 
still yield interesting compositions.  
Other great examples of images 
where you can ignore the ROT rule 
are product-type shots.  Here’s a 
photo I took of a Porsche from on the 
street in downtown Charleston.  It’s 
dead center in the frame.  Of course 
it helps that there is nothing else to 
distract you from the subject of the 
image itself, but it serves as a good 
illustration of when you can throw the 
rules out completely!

Another one of the most fundamental rules in capturing compelling images is that if you have people or live animals in 
the picture, keeping the eyes sharp is the preferred way to go.  Why does this work?  I can’t answer this as analytically as I 
could with the Rule of Thirds because it is much more… well, intuitive.  

For some reason, we are drawn to the eyes of people and animals.  If you are having a conversation with someone and 
they never look you in the eye, you would think that they have something to hide.  The best way I can think of to explain why 
we like to see the eyes of others is because we are, at a very basic level, social in nature.  We need to have connections 
with others.  The same holds true for most animals too.  Wolves travel in packs, penguins huddle in bunches, and birds fly 
in flocks.   We have an almost built-in need to connect with one another.

Part of how we connect is through visual communication.  A sparkle in the eye says someone is feeling happy.  Blankness 
in the eyes can often connote sadness or being disconnected somehow.  Call it a sense of connection if it helps, but on a 
very basic level, we like to see the eyes of others.  As the old saying goes, the eyes are the windows to the soul, and we 
need to have those connections.  Seeing their eyes allows the viewer to connect with the person or animal on some level, 
and it can be a very powerful connection.  So, in seeing that, it’s important to have sharp eyes – otherwise the connection 
is lost and the image doesn’t work as well… most of the time.

Focus on the Eyes
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Just as sharpness can help establish a connection, a 
soft touch that prevents a connection can help an image 
succeed in isolating a subject in their surroundings.  Here 
are a few images where the sharpness of the eyes is not 
as important due to the overall composition of the image.  
As you can see, sharpness of the eyes isn’t always what it 
is cracked up to be.

The final area that we always hear a lot about when it 
comes to “following the rules” is to fill the frame.  As a general 
rule of thumb, we are advised to make sure we have no 
distractions in our images and a good way to accomplish 
that objective is to fill the frame with our subject.  It makes 
sense too, because if you have a lot of distractions the 
viewer will have trouble determining what it is you have 
taken a picture of, or begin to ask what the meaning or the 
purpose of the image is.  Usually the purpose is to draw 
some sort of emotional response to an image.  If you have 
the eye wandering around the image looking for something 
to focus on, you really haven’t engaged the viewer, so to 
that degree, the goal of the image comes into question.

However, there are times where there the entire 
purpose of an image is to capture something different.  
We tend to consider the goal of a photograph as a means 
to an end.  It’s captured to show the viewer someone or 

something.  Without a solid point of focus to really engage 
us, it can often be difficult to express the purpose or the 
reason a particular scene because that we have no idea 
what it is we are supposed to be looking at.

So, what kinds of images make for good examples 
where filling the frame isn’t as relevant?  Several types 
of scenes can make for really effective and compelling 
images.  One such example would be capturing an 
abstract of some sort, whether it be the clouds on a misty 
morning, the patterns of wind-swept sand on an empty 
beach, or even converging lines of an impressive piece of 
architecture.  Other examples could be to demonstrate the 
scale of something, such as a mass of people’s heads as 
they begin the Boston Marathon, or get funneled through 
airport security.  

Fill the Frame
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The entire frame may be filled with portions of people or things, but without any centralized point of focus for the 
viewer to visually grab a hold of.   Abstract imagery is all around us, and recognizing the value in those images can 
be just as meaningful as capturing a sunset, the bride and grooms first kiss, or the wining touchdown of a football 
game.  Another great example of when filling the frame isn’t necessary is one where we have incorporated the idea of 
“negative space” as mentioned above.  The frame in those cases certainly is not filled, and yet the composition can be 
quite effective when captured effectively. 

The upshot of all this is not to say that you should go out and begin to break the rules of composition, because the 
rules are there for a reason.  The rules of photography define parameters that we can begin with as we seek to capture 
compelling images of the world around us.  Knowing what has worked in the past and why can help us to capture things 
effectively in the here and now and further down the road.  Don’t forget that embracing the rules of photography can help 
in the near term and the long term.  

As you capture more and more images that 
embrace the constraints of popular convention, the 
more you can understand why such conventions exist, 
and the more you can begin to explore the visions that 
speak to you specifically.  That is when photography 
really can become even more powerful than you ever 
imagined.  It’s times like these when you find an “inner 
voice” and can begin to explore how to express that 
vision using whatever conventions work best for you.

Once you understand why the conventions exist, 
then the better equipped you will be to explore beyond 
the normal approaches to photography in expressing 
your own personal vision.  It can be a very exciting 
experience to have an epiphany like that and explore 
ways to bring that vision to life – especially when it 
eschews the traditional ways in which visions are 
brought to life.  That is when you really have broadened 
your horizons.  As said by notable poet and author 
Brendan Francis, “Once we accept our limitations, 
we can go beyond them!”  Embrace the constraints 
because in doing so, you can hopefully move past 
them and increase your potential for the unique vision 
we all are always in search of!

In Summary...

This article and all images contained are Copyright © and courtesy of Jason Anderson. Please contact the author directly with any questions.
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Nothing can ruin a beautiful friendship like money, 
especially when it comes to turning photography 
from a beloved hobby into a career. 

I have been shooting professionally for 15+ years 
working on staff for newspapers like the Los Angeles 
Times and the San Bernardino Sun and freelancing for The 
Source Magazine, record labels, and public relations firms, 
shooting everything from world renowned rappers, to bar 
league baseball, and CEOs to street vendors. My whole 
life is photography. I spend all my money buying new gear 
and all my free time either practicing new techniques or 
doing self-promotion. I love working as a photographer. I 
have loved it almost all of the time, but there were times 
when I just did not feel like shooting. 

I have loved photography my whole life so the first time 
I didn’t feel like going to work as a photographer, it scared 

me. I always had a camera with me no matter where I 
went. I was the family member and friend that others knew 
would be around with a camera, so when I started showing 
up without one to social functions I was not the only one 
who was worried. My friends would ask me if my camera 
was broken or if I forgot it and I would simply reply, “No, I 
just didn’t feel like shooting today.” I used to see pictures 
everywhere sometimes opening my eyes was like looking 
through a viewfinder. One day that stopped, my viewfinder 
eyes were gone and I knew something needed to change. 

When you work on staff for a newspaper you get to 
shoot some of the best assignments a photographer can 
ask for and you also get a ton of the same boring “no 
please, I have already shot 20 grip and grins this week” 
assignments. I was not motivated and my work was not 
inspired. My photo editor at the time suggested that I do 
something I had never done in my professional life, take 

5 TIPS TO KEEP THE FUN FLOWING AFTER GOING PRO - By Lawrence Dortch

going Pro: Becoming the Photo-Preneur
HOW TO GO FROM AMATEUR PHOTOGRAPHER TO ENTREPRENEURIAL PROFESSIONAL

http://www.photographybb.com
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a vacation. As soon as it was confirmed I was going on 
holiday I subconsciously knew I wanted to separate the 
photography I was going to do while on vacation from the 
photography I did at my 9-to-5. I went out and bought a 
Contax G1 camera and three lenses. 

Tip 1: Keep a separate camera for 
fun, not for business

If you can’t afford a separate camera then have a 
special lens you use just for pleasure not for work. 

 
When you love what you do it almost seems silly to 

separate your professional and private lives but sometimes 
that is exactly what you need to do and having a camera 
only for personal use can aid in that. Having a personal 
camera or lens that you only use for your own projects helps 
the mind keep a dividing line between your professional 
and personal photography. 

I recently bought a Leica DLux 4, partly because it 
is the only digital Leica I could afford, but also because 
there is no way I can use that camera for work as I am 
currently a sports photographer. When I pick up my 
Leica I know the only person I am shooting for is myself; 
I know I am not going to work. If a new camera is not 
for you, try a new lens. A nice macro or telephoto lens 
for shooting sports or wildlife can also be a lot of fun to 
play with. 

Whether you shoot fashion, sports or weddings after 
a while it all becomes a blur and that can cause you 
to lose your creative edge. Some people don’t need 
a separate camera or lens to draw that line between 
personal and professional they just need something 
outside their norm to shoot.

Tip 2: Develop a Passion Project
When shooting professionally often we have to 

photograph what others want in order to make a living but 
with a passion project we can shoot whatever we want and 
show it or not show it. 

There are a few things to consider when developing 
a passion project like what were the subjects you used to 
shoot when you were an amateur? Did you photograph 
models or landscapes? What is something or some place 
you have always wanted to shoot but haven’t made the 
time? Have you always wanted to photograph a hot sports 
car? Consider attending a car show. Maybe you have 
always wanted to shoot a tiger, check out the nearest zoo 
and speak to the zookeepers and find out when is the 
best time of day to photograph them. 

What is something completely different from what 
you shoot professionally? If you normally are a wedding 
photographer call your local newspaper and offer to cover 
regional pro sports teams for free. Newspapers nowadays 
are often working on skeleton crews and will take all the 
help they can get. When speaking with photo editors asking 
to cover minor league games or pro women’s sports is a 
great way to get your foot in the door, have some fun, and 
shoot something completely different than your norm. 

These are just some of the questions and considerations 
to ask yourself when developing as passion project. Most 
importantly remember the project should be fun and 
challenging — something you want to shoot; something 
when you think about it gets you excited. 

Tip 3: Learn a new shooting or 
editing technique 

Just like having a new piece of gear, a lens, camera, 
flash, etc… can make shooting more fun, learning new 
editing and shooting techniques is like having brand new 
toys to play with expect these toys are free. 

Professional classes can be expensive but there is no 
need to pay thousands of dollars to learn when the world’s 
finest educational resource is just a www away. There are 
literally thousands of online resources for photography 
including great publications like Photography BB magazine. 
In issue #30 alone there were numerous articles of both 
shooting and editing techniques including retouching eyes, 
cropping, and tips for wildlife photography. 

http://www.photographybb.com
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Some people learn by reading others learn through 
watching and listening and for those people YouTube 
is your friend. There is almost nothing you can’t find on 
YouTube from Aperture training, Photoshop techniques, 
to some of the world’s most accomplished photographers 
demystifying lighting schemes. 

Other people learn by doing so don’t forget about 
the old fashioned tried and true method of learning, 
photo clinics. If you open just about any photography 
magazine on the rack you will find advertisements for 
workshops and clinics that you can travel to —some 
even tour to various cities. While these workshops can 
be expensive many of your local camera stores offer 
seminars at low or no cost. A great benefit to attending 
workshops in person is that you have the opportunity to 
meet and socialize with other photographers. 

Tip 4: Participate in the 
photography community

Photography is fun alone but it is even better together. 
The photography community is vast and wide with 
photographers and editors doing more than just sharing 
their knowledge but also sharing time. In many towns there 
are Meetup groups. Meetup is a website where millions 
of people of similar interest can find each other and meet 
in groups. Many top shooters and editors organize photo 
walks or portfolio reviews in their local towns or in areas 
that they are visiting. Say you want to try your hand at 
fashion photography but don’t know any models, Meetup 
has groups that organize shoots so all you have to do is 
join the group show up and shoot.

If joining a photography group offline is not your 
thing then check out an online community like Flickr. 
Unlike Meetup, Flickr is specifically for designed 
for photography and there are tens of thousands of 
groups you can join. There is a group for every flavor 
of photography even with certain groups dedicated to 
the type of equipment you own so you can share and 
compare with people using similar setups. 

Finally, one of the best ways to participate in any 
community is to give back, to share your knowledge and 
ideas. There are many wonderful publications on and 
offline that are always looking for user generated content. 
So if you can, submit an article or share your pictures 
because giving is fun.

Tip 5: Treat Yourself! 
Lastly, and I think most importantly, treat yourself, buy 

yourself something nice, non-photography related. 

Photography is an exciting job, a fun job, at times 
even a sexy job but it is still just a job, so every once in a 
while do something to remind yourself of why you turned 
your wonderful hobby into a profession and spend some 

of that hard earned money on yourself. As photographers 
when we get extra money we have a tendency to buy 
more camera equipment, however the next time you find 
yourself with disposable income buy yourself something 
non-photography related. Pick out a nice watch, a new 
pair of shoes, book yourself a cruise and do something 
nice for yourself; not something good for your career - just 
something good for you!

This article and all images contained are Copyright © and courtesy of Lawrence Dortch. Please contact the author directly with any questions.
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Find a problematic image, maybe poorly exposed or with a colour cast and with the image open try the following 
commands in turn:

	 	 	 	 •	Auto	Tone	(previously	called	Auto	levels)
	 	 	 	 •	Auto	Contrast	
	 	 	 	 •	Auto	Colour

It does depend on the image, but generally I have found Auto Colour to give a better result. Auto Colour invokes 
a tone or “levels” adjustment as well as re-mapping colours. All of these can be found in the Image menu. CS3 has 
them hiding under the Adjustments sub-menu but with the newer versions (as in CS5 shown below) it’s in your face. 

With the same image 
open, experiment with a two 
or three crops (see last issue) 
getting successfully smaller 
and smaller. With this same 
image go to Image/Image 
Rotation (previously Rotate 
Canvas) and experiment with 
the options there:

 
Note: Where the option reads 
900 CW the CW means “Clock 
Wise” and CCW is Counter 
Clock Wise.

The purpose of doing all 
these steps is to build up a 
visual history session with this 

SPEED THINGS UP AND TRAVEL THROUGH TIME - By John Ogden

As we saw last issue some enhancements and effects are created using the tools in 
Photoshop’s toolbox and others via the menus. The following activity encourages you to 
use some of the most common enhancements from both areas and will open your eyes to 
the awesome power of Photoshop time travel!

Part Iv

http://www.photographybb.com
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image which includes both navigating menus and using tools from the tool box. Often when working on images in 
Photoshop, you will go through several steps of processing, and may wish to backtrack or start over from a certain 
point. Off the top of your head, do you remember what you step you did prior to cropping your image? If not, don’t 
worry; there is an easy way to keep track and see exactly what you have been doing!

History Panel
Last month we looked at setting up your Photoshop “workspace,” and in doing so I asked you to include the 

History Panel in your workspace. Here you can see how it works. If it is not already open, open the History Panel 
by clicking on its name on the collapsed panel icon. You should see a list of events or History Steps with the most 
recent of your processing steps showing at the bottom of this list. 

You can click on any of these history steps to view your project at every stage, be sure to click on the text label 
rather than any icons. This is a great learning tool: use it to back-track if you make an error or get stuck. 

 

Unfortunately the history is lost when the image is closed down or if you overwrite with new steps, so it is only 
good for the current session. By default Photoshop remembers approximately 20 steps, but you can bump this up 
in the preferences menu (Edit > Preferences…). However, the more steps you make Photoshop “remember,” the 
more memory resources your computer will use.

To Summarize: 
- Some tools are found in the tool box, some via the menus. Explore Photoshop’s menus and features!
- You can speed things up with auto corrections, and blaze through your processing workflow.
- Don’t worry if you make any mistakes or want to start over. You can travel back into history!

This article and images contained are Copyright © and courtesy of John Ogden.  Please contact the author directly with any questions.
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In this month’s tutorial we’re going to use something 
called shape-layers along with layer styles in 
Photoshop in order to achieve the effect of creating a 
single image from a collage of individual images.

The end result is an effect which will blow your viewers 
away! Little will they know that this is actually a simple 
Photoshop technique which takes less than 10 minutes 
to perform!

As I mentioned above, there are two parts to this 
tutorial, each of which can be used separately in your 
future work, but for the purposes of this tutorials we 
are going to put them both together. But first, we need 
to prepare our image, so let’s get started!

Step 1: 
First, we need to start with a suitable photo. Open one 
of your own images in Photoshop.

Step 2: 
Go to the menu: Edit	>	Define	Pattern...

When the dialog box pops up, just click OK. You won’t 
see anything happen with your image, but this important 
step will become useful to us later on. 

For those of you who are wondering, you just loaded 
your whole image as a pattern.

SCATTERED-PHOTO COLLAGE EFFECT:  By Dave Seeram

Adobe Photoshop® Tutorial
TECHNIQUES, TIPS, AND TRICKS FOR DIGITAL EDITING OF IMAGES IN PHOTOSHOP®

The presentation of your digital photos is everything when it comes to showcasing 
your unique photos on the web. This month, we’re going to take a look at a two part 
tutorial where you’ll learn a great technique for creating a digital backdrop, as well as an 
extremely effective photo-collage layout which can be accomplished in mere minutes!

http://www.photographybb.com
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Building the Backdrop

Step 3:
Create a new by clicking the “Create a New Layer” 
icon at the bottom of your layers palette.

Now press Shift-Backspace (PC) or Shift-Delete (Mac) 
which opens the Fill... dialog box.

Chose 50% Gray for the fill color, and uncheck 
“Preserve Transparency.”

Step 4:
Go to the menu: Filter	>	Noise	>	Add	Noise...
and use the slider to create a decent amount of noise 
on this layer. Select Gaussian for the distribution, and 
check the Monochromatic box ON.

Click OK!

Step 5:
This next step does something pretty cool in turning 
this noisy layer into a nice backdrop.

Go to the menu: Filter	>	Stylize	>	Emboss...

You can leave the default angle where it is (unless you 
feel like experimenting of course!), keep the height at 
1 pixel, and the amount at 100%.

Click OK!

http://www.photographybb.com
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Step 6:
We’re going to spruce this backdrop up even more by 
adding some layer styles to it.

Go to the menu: Layer	 >	 Layer	 Styles	 >	Gradient	
Overlay

Here you’ll want to change the blend mode to “Soft 
Light”, reduce the opacity to approximately 55% or 
to your liking, check the Reverse checkbox ON, and 
change the gradient style to “Radial.”

This will produce a nice lighting effect over this layer.

Step 7:
Again, this layer is going to serve as the backdrop for 
our collage, so let’s add a touch of color to finish it 
off. While holding down the Alt key (PC) or Option key 
(Mac), click and hold the “Add Adjustment Layer” icon 
at the bottom of the layers palette, and when the menu 
appears, select “Solid Color.”

The Adjustment Layer dialog box will open, and it’s 
important to make sure the “Use Previous Layer to 
Create Clipping Mask” checkbox	is	checked!

Choose any color you would like, click OK, then 
change the blending mode of this layer to “Soft Light.”

Building the Collage

Step 8:
From the toolbar, select the Rectangle Tool (U). In the 
Options Bar at the top of the screen, make sure the 
Shape Layers icon is active (on the left) and choose a 
nice neutral gray color (on the right), any gray will do. 
See the next page for details.

http://www.photographybb.com
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Step 9:
Now go back to your image and draw a small rectangle. 
You will see a new shape layer is automatically created 
in the layers palette.

This layer is going to be the base layer for the 
“snapshots” we are going to use to make our collage. 
Before we go any further, let’s use some more layer 
styles and make this box look more like an individual 
photograph.

Step 10:
Go to the menu: Layer	>	Layer	Styles	>	Stroke...
First change the color (at the bottom) to white then 
change the Position to “Inside.” Lastly, use the size 
slider to create a nice photo border. The pixel size that 
you use will depend entirely on your image’s resolution 
and size, and how thick you’d like these borders to 
appear. 

Don’t click OK just yet, we need to add another layer 
style to this layer!

Step 11:
Click on Pattern Overlay from the list of layer styles on 
the left of this dialog box, and make sure the Pattern 
Overlay checkbox is checked.

You will probably see a strange default pattern. Click on 
this pattern’s thumbnail, and select the defined image 
pattern you created earlier. It will look like your photo, 
and should be last in the list of patterns available.

Uncheck the “Link with Layer” checkbox, and click on 
the “Snap to Origin” button, and now you can click OK 
to close this dialog box!

http://www.photographybb.com


Pa
ge

 4
1

PhotographyBB Online Magazine www.PhotographyBB.com

Step 12:
Things are really starting to shape up at this point! 
Press Control-T (PC) or Command-T (Mac) to bring up 
the Transform tool.

If you hover the tool over one of the corners, you can 
rotate this box a little to give your collage a scattered 
photo type effect.

Once you have rotated it to your liking, click Enter (PC) 
or Return (Mac) to commit the transformation.

Step 13:
While holding down the Control-Alt keys (PC) or 
Command-Option keys (Mac), you can use the mouse 
to click and drag a copy of this “frame” right on your 
image canvas.

Use the Transform tool again (as in the previous step) 
to rotate this object to your liking.

Continue this process as many times as you would 
like. You can use the Transform tool to rotate and 
slide these images around, and you’ll see how they 
automatically allow the “pattern” (which is actually your 
photo) to show through. Now that’s cool!

http://www.photographybb.com
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Final Result
The great thing about this effect is how simple it is to setup the first “photo” and duplicate it as many times 

as you like to create this collage effect. In the end, it looks as though you took several photos of one scene, and 
stitched them painstakingly together in Photoshop. Little will your viewers know that you actually only took one 
photo, and the entire collage was accomplished in minutes!

Tweak the Backdrop Color
If you recall earlier, we created a Solid Color Adjustment Layer back in step 7, and we “clipped” it to the layer 

which serves as the collage backdrop. We colored the backdrop this way so that it is super-duper easy if you see 
the final result and decide that you’d rather have a different backdrop color. Instead of re-building the backdrop layer 
over again from scratch, you can simply double click on the Solid Color Adjustment Layer, and choose a different 
color for your backdrop - and voila!

I hope you have enjoyed this tutorial on creating Photoshop collages. There are several different techniques in 
this particular tutorial which I am hoping you will be able to apply to other processes. As with all Photoshop tutorials, 
the most fun comes from experimenting. I encourage everyone to take some time and play around with the different 
options and sliders in some of the dialog boxes we used in this tutorial.

Until next time... Happy Photoshopping!

This article and images contained are Copyright © and courtesy of Dave Seeram.  Please contact the author directly with any questions.
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Assignment: Black and White 
Last month the assignment theme was Colour Contrast, so this time around we elected to go with the opposite, and challenge 
our members with the theme of Black and White. There were so many fantastic entries and higher participation levels on this 
assignment; you can see more great entries here. These are the top selections we came up with for this assignment:

Top: Photo by member “Tom B” Bottom Left: Photo by member “rene52.” Bottom Right: Photo by member “Tassie Anna”.
Thank you to all of our photography assignment participants. We look forward to your submissions in our ongoing bi-weekly assignments.

http://www.photographybb.com
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Right:  Best of June 2010 - Photo by: Mayur Kotlikar
http://www.flickr.com/photos/mayurkotlikar/

Top Right: Black and White - Photo by: Anh Vo
http://www.flickr.com/photos/anhvophotography/

Top Left:  “Black and White” - Photo by: Sue90ca
http://www.flickr.com/photos/sue90ca/

PhotographyBB flickr group Member Photos
The PhotographyBB Gallery group on flickr® is the latest place for flickr® members to participate in PhotographyBB 
Assignments. Each month, in addition to choosing our top photos from the PhotographyBB Forum submissions, we’ll also 
be selecting some images from the talented members of our flickr® group to showcase their photography. Click on the links 
under each photo to view the flickr® gallery of the photographer who submitted the photo.

bottom Left: Best of June 2010 - Photo by: jajjen
http://www.flickr.com/photos/jajjen/

http://www.photographybb.com
http://www.flickr.com/photos/mayurkotlikar/
http://www.flickr.com/photos/anhvophotography/
http://www.flickr.com/photos/sue90ca/
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Do you have a 
Great Idea for 

a Photography 
Article?

We are looking for 
talented individuals 
who would like to 
expand their portfolios 
by volunteering to 
contribute articles to 
this e-magazine! If you 
are interested, we’d 
love to hear from you.

Topics of Interest are:

- Photography Techniques
- Photography on Location
- Photoshop Tutorials
- Hardware / Software Reviews
- Camera Equipment
- Member Spotlight
- Plus we’re open to new ideas!

To become either a regular 
contributing author, or even 
just for a one-time article, 
please email us at: 

magazine@photographybb.com

Introduce yourself, share your 
idea, and maybe we’ll see you 
in next month’s issue!

Step into the Spotlight!
Would you like to be featured in the PhotographyBB 
Online Spotlight on Member section? If so, please let 
us know at: magazine@photographybb.com

We’ll feature your photos, a small biography and write-
up about you, as well as links to your web gallery or 
photography related business. We all love photography 
and image editing, so let’s get to know each other!

Been Around the World?
We are looking for talented writers who would like 
to share their experiences in visiting far away places, 
or even your home town for that matter. In our 
Photography Around the World column, we take our 
readers on a photographic journey, and we would like 
you to be our tour guide.

If you would like to share your story and photography 
of a city you have visited, please contact us and share 
your idea with our team. We’d love to hear from you!

RSS Updates Available:
There have been some requests for email notifications  
of upcoming issues of the PhotographyBB Magazine 
Online. You can receive updates on the magazine as 
well as our blog postings through our RSS feed which 
can either be aggregated to your feed reader, or 
emailed to your email address. Any of our readers who 
are interested can subscribe here:
http://feeds2.feedburner.com/photographybb

Discounts for Readers:
For those of you who are interested in getting into HDR 
photography, there simply is no better HDR software 
then HDRsoft’s Photomatix Pro, available as a stand 
alone software and as a Photoshop Plugin. Visit:
http://www.photographybb.com/hdr/
and use the coupon code: photographybb.com 
for a special discount. Also, check out the Shop 
PhotographyBB site for links to some great deals on 
cameras and accessories. Best deals on the web!

Thank you for reading the PhotographyBB Online 
Magazine. We hope  you enjoyed it, and we’d love to 
see you again next month. If you have any questions or 
comments for us regarding this magazine, please feel 
free to email us at: magazine@photographybb.com

http://www.photographybb.com

